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Manufacturer’s note:

This product bears a CE marking in accor-
dance with the provisions of council directive
93/42/EEC of June 14th, 1993 for medical
devices.

The CE marking applies only to medico-tech-
nical products/medical products introduced in
connection with the above-mentioned com-
prehensive EC directives.
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System Information

System type:

Serial number:

Gradient configura-
tion:

Connected cam-
eras:

Software options:

Customer service 
phone numbers:
V
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Vessel View gives you:

❏ 3D view in VRT or MIP mode supple-
mented by MPR or MIP slice images

❏ Common VRT gallery with 3D task card

❏ Clip planes and VOI tool for processing 
a volume

❏ Semi and fully automatic generation of 
vessel paths with segmentation

❏ Manual path definition and segmenta-
tion (vessel tube)

❏ Vessel navigator for generating and dis-
playing a ribbon MPR for special evalua-
tion

❏ MIP view in vessel navigator

❏ Automatic preparation of a stenosis 
evaluation

❏ Distance, curve, area, and angle mea-
surement

❏ Automatic determination and measure-
ment of vessel cross-section

❏ Object list for overview and manage-
ment of created objects

❏ Automatic generation of axial vessel 
slice images

❏ Transfer of image data to graphic slice 
positioning (GSP)

❏ Recording of action sequences and rota-
tions of the view
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Introduction

We are pleased to welcome you as a user of
the powerful software syngo MR used to
operate Siemens MAGNETOM MR systems.

This Quick Guide will help you with evalua-
tion of vessel images using Vessel View. It
focuses on simple and fast performance of
typical actions. This Quick Guide is only valid
in conjunction with the system manual and
the safety information contained therein.

Step-by-step instructions are given on the
right. Supplementary figures and notes can
be found on the left. 

A full guide to using the software syngo MR
is provided in the User Manual and in the
comprehensive Online Help. To call up the
Online Help press F1 on your keyboard or
click the Help button in the active dialog box.

The Vessel View Quick Guide contains the
following topics:

❏ Loading and viewing Images
❏ Defining vessels
❏ Evaluating vessels
❏ Saving and documenting evaluations
❏ Workflow of a Carotis examination
V
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If you have not yet opened Vessel View,
the application opens as soon as you load
images.
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Loading and Viewing Images

Requirements

You cannot open several series simulta-
neously in Vessel View. Any series you open
must meet the following requirements:

❏ The series must comprise at least three 
images.

❏ All images must be of the same patient.
❏ All images must be parallel and acquired 

along one axis.
❏ Each image must have a different slice 

position.
❏ The distance between two adjacent slices 

must not exceed 5 times the average slice 
distance.

❏ All images must have been recorded within 
30 minutes.

Loading images

✧ Open the Patient Browser and select an 
image series.

✧ Click the Vessel View button on the tool 
bar of the Patient Browser.

Or

✧ Select Applications > Vessel View from 
the menu bar of the Patient Browser.
V
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Loading and Viewing Images
Layout of Vessel View task card

(1) Slice image segments:
MPR, MPR Thick display, MIP or 
MIP Thin display

(2) Volume image segment:
VRT or MIP display

(3) Control area 

(4) Evaluation area 

Depending on your task you can
select any of the following functions
from the Vessel View pop-up menu:

❏ Edit Path switches path editing mode for 
the selected path on or off.

❏ Zoom/Pan switches zoom/pan mode on or 
off.

❏ MIP Mode switches MIP mode for the vol-
ume image on or off.

❏ Translucent activates translucent view of 
segmented vessels in the volume image.

❏ Accept Contour accepts a contour sug-
gestion in the lower slice image segment 
as the area measurement.

❏ Edit Contour activates or deactivates 
change contour mode for a contour in the 
lower slice image segment.

❏ Freehand ROI activates or deactivates 
draw mode in the lower slice image.

❏ Send to GSP transfers the image coordi-
nates of the selected MPR segment to the 
Examination task card for graphic slice 
positioning.
V
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You can set the slice thickness for
MPR Thick and MIP Thin by right-
clicking the button.

You can edit VRT parameters in detail on
the Definition tab card.
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Loading and Viewing Images
Setting the image view

Switching display modes

Depending on which segments you are work-
ing on, the following display modes are avail-
able to you on the Type task card:

(1) MPR 

(2) MPR Thick, slice thickness selectable

(3) MIP, projection of the full volume

(4) MIP Thin, slice thickness selectable

(5) VRT for volume image display

✧ Click the relevant button or select the 
mode from the Type menu.

Selecting a VRT parameter set for volume
image

✧ Right-click the VRT button on the 
Type subtask card of the control 
area.

The VRT Definition & Gallery dialog box
opens with the VRT Gallery subtask card. If
the check box on the subtask card is deacti-
vated, the VRT gallery is automatically dis-
played when you start Vessel View.

✧ Select a suitable VRT parameter set for 
your evaluation.

The VRT volume image is displayed including
the respective tissue class parameters.

✧ Close the dialog box.
V
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Loading and Viewing Images
Enlarging an image segment

✧ Select the image segment to be enlarged.

✧ Click the Full Screen button in the control 
area.

A small image segment is transferred to the
center of the task card. This is how the center
image segment is enlarged to full screen
height and restored to its original size.

Zooming and panning

✧ Click the Zoom/Pan button in the control 
area.

Or

✧ Select Zoom/Pan from the pop-up 
menu.

✧ To zoom, move the mouse at the image 
edge keeping the mouse button pressed.

Or

✧ To pan the image, move the mouse keep-
ing the mouse button pressed in the image 
center.
V
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In vessel orthogonal orientation, the two
upper slice images stacks cannot be
scrolled and the reference lines cannot be
moved.

With this control area button you
can show or hide the reference
lines.

You can put the slice image
planes into a standard orientation
with this button on the Orienta-
tion subtask card.
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Loading and Viewing Images
Scrolling through the slice image stacks

You can scroll slice by slice through an image
stack with the dog ear:

✧ Click on the dog ear in the image stack to 
scroll back.

Or

✧ Click into the empty corner in the image 
stack to scroll forward.

You can move the image planes steplessly
with the reference lines:

✧ Move the mouse pointer onto the refer-
ence line near the center of the image.

✧ Move the line to the desired clip position 
keeping the mouse button pressed.

Rotating the slice image plane

✧ Move the mouse pointer onto the refer-
ence line at the image edge.

✧ Rotate the line in the desired direction 
keeping the mouse button pressed.
V
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If zoom/pan mode is active, deactivate it if
you want to rotate the volume image manu-
ally.

Use this button to store the image
sequence of a 360° rotation in the
database or in an avi film file.
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Loading and Viewing Images
Rotating a volume image

✧ Rotate the volume image in the desired 
direction keeping the mouse button 
pressed.

To gain an overview, allow the volume to
rotate automatically:

✧ Select the volume segment and click this 
button in the Movie subtask card.

✧ Set a rotation speed with the slider.

✧ To stop rotation, click the Stop button.

The image last visible is displayed again.

Orienting the volume image

✧ Click the orientation cube surface that you 
want to place in the foreground of your vol-
ume image.

Or

✧ Double-click anywhere on the orientation 
cube to display the volume image both 
from the front and in its original size.

Setting view options

The Configure menu allows you to enter
basic settings for working with Vessel View.
This is where you activate (checkmark) or
deactivate (no checkmark) modes or select
particular settings from the submenu.
V
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The MIP mode is especially suitable for
defining VOIs.

You cannot draw VOI contours in slice
image segments.
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Defining Vessels

Removing unwanted parts of the 
image

Defining and cutting out VOIs

✧ Orient the volume image for easiest trac-
ing.

✧ Click the Draw Contour button on the VOI 
subtask card.

✧ Draw round the volume area of interest 
keeping the mouse button pressed.

✧ Double-click to complete the contour.

✧ Click the Include button to expose the vol-
ume inside the contour.

Or

✧ Click the Exclude button to hide the vol-
ume inside the contour.

The VOI is cut and draw mode deactivated.

V
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Hold down the Ctrl key to move all visible
clip planes simultaneously.

Hold down the Shift key to move all clip
planes freely.
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Defining Vessels
Using clip planes

You can move the clip planes between areas
of interest and hidden areas. The volume out-
side the clip planes is hidden.

✧ Click the clip planes that you want to use 
on the Clip subtask card.

✧ In the volume image place the mouse 
pointer on the clip plane and move the 
mouse forward or back to move the plane.

✧ Drag the edge point to tilt the plane.

✧ Click the highlighted clip planes on the 
cube to hide them again.

The clip planes are still active but no longer
visible.

Resetting clip planes

✧ Click the button on the Clip subtask card.

All clip planes return to their original position.
The full volume is visible again.
V
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The button for the segmentation tool you
last used is offered as the default next to the
arrow.

You can use all image segments for setting
landmarks.

You can change the views as much as you
want between setting landmarks. You can
move or delete landmarks that are already
set.

To activate or deactivate translu-
cent mode manually, select or
deselect the Translucent option in
the pop-up menu.
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Defining Vessels
Creating and editing paths

Semi-automatic path planning

✧ Display the Measurements subtask card 
in the evaluation area.

✧ Click the Semi Automatic Path Creation 
button.

Or

✧ Open the tool list for path planning with the 
arrow and select Semi Auto Segmenta-
tion.

The dialog box for controlling semi automatic
path creation opens.

✧ Set at least two landmarks by clicking the 
mouse in the vessel section you want to 
segment: one at the beginning and one at 
the end of the section.

✧ Start segmentation.

The segmentation algorithm automatically
finds the vessel limits and determines the
vessel centerline (path).

After segmentation transparency is set to
85% (translucent mode) in the VRT settings
to make the paths more visible in the volume
image.

Using the Fader slider on subtask card VOI
you can set the visibility of the volume parts
hidden during segmentation to values
between 0 (= fully hidden) and 100 (= fully vis-
ible).

✧ Move the slider to the right to increase vis-
ibility or to the left to reduce it.
V
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Limit the volume to be evaluated to one VOI
to increase the efficiency of fully automatic
segmentation.
→  Page 21, Defining and cutting out VOIs
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Defining Vessels
Repeated semi-automatic creation of paths

You can create paths semi-automatically on
data sets that have already been segmented.
You can use this method to define additional
vessels.

The result of the new segmentation is added
to the volume already defined. When you
start path planning the volume parts hidden
by vessel segmentation are displayed again
exposing the entire volume for setting land-
marks.

Fully automatic path creation

Fully automatic path creation defines the
entire vessel tree.

✧ Display the Measurements subtask card 
in the evaluation area.

✧ Click the Automatic Path Creation but-
ton.

Or

✧ Open the tool list for path planning with the 
arrow and select Semi Auto Segmenta-
tion.

Paths are created fully automatically along
the vessel tree. The tissue that does not
belong to the vessel tree is hidden and trans-
lucent mode is activated.

✧ Set the visibility of the hidden volume parts 
to the required value with the Fader slider 
on the VOI subtask card.
V
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How well a manually created path repre-
sents the actual course of the blood vessel
depends on the number of path points used
and how accurately they are positioned.

You can use all image segments for setting
path points.
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Defining Vessels
Manual path planning

For manual path creation, you need to set all
path points by hand. No segmentation algo-
rithm is executed.

✧ Display the Measurements subtask card 
in the evaluation area.

✧ Click the Automatic Path Creation but-
ton.

Or

✧ Open the tool list for path planning with the 
arrow and select Manual Path Creation.

The dialog box for controlling manual path
creation opens.

✧ Set a path point at the beginning of the 
vessel.

✧ Set an additional path point at the vessel 
center if the direction of the vessel 
changes.

✧ To complete path creation, click Apply.

✧ To make the path line in the volume 
image easier to see select the 
Translucent option from the pop-
up menu.
V
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You can select any radius between 0 and
50 mm for the vessel tube. The tube should
fully include the vessel.
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Defining Vessels
Defining vessels

You can expose vessels with a path as a tube-
shaped VOI.

✧ Select the path of the vessel that you want 
to expose from the object list or in the vol-
ume image.

✧ Click the Tube Mode button on the VOI 
subtask card of the control area.

The vessel tube will be displayed with a trans-
parent surface in the volume image.

✧ Set the tube radius to the required value.

✧ Click the Include button to expose the ves-
sel tube.
V
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If you want to add another path to a path
that already exists you can create a new
path by repeating semi-automatic segmen-
tation.

If the two linked paths are not contiguous,
the gap will be bridged by the shortest con-
necting line.
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Defining Vessels
Managing paths

The object list on the Measurements subtask
card shows each path with a unique name.
You can change the name of a path, store
notes on each path, or delete paths you no
longer need.

Connecting paths

You can create a new contiguous path from
two individual paths using the connection
tool.

✧ Click the first path to be linked in the object 
list.

✧ Hold the Ctrl key on your keyboard 
pressed and click the second path to be 
linked.

Both paths are now marked.

✧ Click the Connect button.
V
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Volume image view Slice image view
not vessel orthogo-

nal

Slice image view
vessel orthogonal

In the vessel orthogonal slice image you
can only move the path point of intersection
with the image plane. The path is updated
automatically.
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Defining Vessels
Changing the course of a path

You can change the position of the path by
moving, inserting, or removing path points.

✧ Select the path to be edited in the volume 
image or object list.

✧ Click the Edit path button on the Measu-
rements subtask card.

Or

✧ Select the Edit path option from 
the pop-up menu for the selected 
path.

The path points are now visible.

✧ To select a path point, click the point.

The selected path point is highlighted with a
color and the image views change to the posi-
tion of the point.

✧ To delete a selected path point press the 
Del key.

✧ Click a point on the path to insert a path 
point.

To move a path point in the volume image:

✧ Click directly on the path point and drag it 
to the desired position using the mouse.

To move a path point in a slice image:

✧ Move the mouse pointer toward the path 
point until the shape of the mouse pointer 
changes.

✧ Drag the path point to the required position 
holding the mouse button down.
V
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In vessel orthogonal orientation, the two
upper slice images stacks cannot be
scrolled and the reference lines cannot be
moved.

If you have created a new path, the slice
image segments are automatically set in
the orthogonal vessel orientation.
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Evaluating Vessels

Setting vessel orthogonal orienta-
tion

In vessel orthogonal orientation the slice
image planes are automatically aligned in the
vessel path. The lower slice image plane lies
perpendicular to the vessel path and shows
the vessel cross-section. All three image
planes are perpendicular to each other.

✧ Select the path of the vessel from the 
object list or the volume image.

✧ Click the Vessel Orthogonal button on the 
Orientation subtask card.

If you want to be able to move the slice image
planes again, deactivate vessel orthogonal
orientation again:

✧ Unclick the Vessel Orthogonal button.

V
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The starting and end position are defined in
millimeters from the beginning of the path.

If you want to change the starting and end
position by the same amount, move the
slider using the middle handle.
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Evaluating Vessels
Generating axial vessel section 
images

You can document a defined vessel with a
series of axial vessel section images in MPR
format.

✧ Select the path of the vessel from the 
object list or the volume image.

✧ Click on the Axial Cuts button in the lower 
part of the control area.

The Axial Cuts dialog box is opened with
default settings. A symbolic preview of the
section image series is shown in the volume
image.

✧ Drag the left slider handle to the required 
start position.

✧ Drag the right slider handle to the required 
end position.

✧ Type the interval between images.

The graphic display of the section image
planes in the volume image is updated.

✧ Click Start.

The axial MPR section images are calculated
and stored in the database as a series. The
number of images automatically results from
the distance between the starting and end
position and the image interval.
V
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40
In MPR mode the image plane rotates in 5°
steps, in MIP mode, in 45° steps.

You can start automatic rotation and store
the image sequence on the Movie subtask
card.

You can set the slice thickness for
MIP Thin as for other image seg-
ments by right-clicking the button.

You can window the view in the Vessel Nav-
igator identical to the views in the slice
image segments.
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Evaluating Vessels
Evaluation in the vessel navigator

The vessel navigator calculates a longitudinal
section through a vessel along the path (flat
ribbon) and displays the associated MPR or
MIP image. Additional information is provided
by the stenosis curve.

Setting the image view

✧ Select the path of the vessel from the 
object list or the volume image.

✧ Display the Vessel Navigator subtask 
card in the evaluation area.

✧ Place the focus pointer on the point of 
interest by mouse click or drag it there 
keeping the mouse button pressed.

✧ Use the Angle slider to rotate the image 
plane to the required position.

If you want to display an MIP image of the
vessel switch to display mode:

✧ Click the MIP Thin button on the Type sub-
task card of the control area.

If the image contains too much or too little of
the area surrounding the vessel, decrease or
increase the width of the flat ribbon:

✧ Overwrite the default width with your pre-
ferred value and confirm with the Enter 
key.
V
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42
Use this button to store the image
sequence of a 360° rotation in the
database or in an avi film file.

At stenoses the area curve is extremely
low, at aneurysms extremely high.

The less the three diameter curves differ at
a point along the vessel, the more the ves-
sel cross-section resembles a circle.

The equivalent diameter is the diameter of
a circle having the same area as the vessel
cross-section.
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Evaluating Vessels
Automatically rotating the vessel navigator
view

✧ Click this button on the Movie subtask 
card.

✧ Set a rotation speed with the slider.

✧ To stop rotation, click the Stop button.

The image last visible is displayed again.

Defining a stenosis curve

The stenosis curve above the vessel image
gives you an overview of the cross-section of
the vessel and helps you locate medically rel-
evant vessel points. You can choose one of
two different representations.

Area representation (1 curve):
The curve represents the cross-sectional
area along the vessel.

Diameter representation (3 curves):
❏ Curve of the diameter maxima (above)
❏ Curve of the equivalent diameter (center)
❏ Curve of the diameter minima (below)

✧ Select the Vessel Navigator Curves 
option from the Configure menu and the 
required setting from the submenu.
V
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44
Select whether you want to use
one or two normal flags or work
without flags with this button.

Contour suggestions are only
shown if vessel orthogonal orien-
tation is active.

If you are not satisfied with the con-
tour, either edit it or redraw it.

If a flag is not in the correct posi-
tion drag it to the location you
wish to evaluate using the mouse.
To move a flag in the volume
image click directly on the flag ring and
move it to the required position with the
mouse.
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Evaluating Vessels
Stenosis evaluation with flags

The vessel navigator automatically suggests
a point on the vessel for stenosis evaluation.
The suspected stenosis and points for com-
parison measurements are marked by flags:

(1) Flag A before stenosis (normal A)
(2) Minimum flag

Only when three flags are activated:
(3) Flag B after stenosis (normal B)

As soon as you have created a path, a con-
tour suggestion is made for the vessel cross-
section in the lower slice image segment at
the position of the minimum flag.

✧ Check the contour suggestion and click the 
Accept Contour button in the vessel navi-
gator.

The contour is evaluated and the measured
values for the minimum flag entered in the
object list. Now the focus pointer automati-
cally moves to the comparison flag.

✧ Repeat flag acceptance for flag Normal A 
and possibly Normal B.
V
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If you use two normal flags the degree of
stenosis is calculated using the mean value
of the two comparison measurements.
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Evaluating Vessels
The degree of stenosis is calculated (degree
of stenosis = 1 – measured value stenosis
flag / measured value normal flag) and dis-
played in the object list in percent. It can
accept values between 0% (no stenosis of
vessel) and 100% (vessel completely
blocked).

Evaluated flags cannot be moved until the
current stenosis evaluation is complete. As
soon as all flags are evaluated they are
enabled again and can be used to evaluate
other vessel stenoses.
V
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Evaluating Vessels
Performing measurements

Distance measurement in the image seg-
ments

✧ Click the Distance measurement button 
on the Measurements subtask card.

✧ Drag out the line to be measured in the 
slice image.

Or

✧ In the volume image, click the starting 
point and then the end point of the mea-
surement.

Distance measurement in the vessel naviga-
tor

In the vessel navigator you always measure
distances that are perpendicular to the vessel
axis, e. g. vessel diameter.

✧ Set the required view in the vessel naviga-
tor.

✧ Click the Distance Measurement button.

✧ Drag out the line to be measured.

Post-processing a distance measurement

✧ Select the measurement from the object 
list.

The measurement is highlighted in the image
segments.

✧ Move the measurement points to be cor-
rected to the required position with the 
mouse.

The measurement is updated.
V
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The total length of a path and therefore the
associated vessel is given in the object list.

You can continue curved distance mea-
surement by setting further measuring
points on the path. The path line between
the most recent point and the end point of
the last measurement is measured and
entered as a new curved measurement in
the object list.

To end curved distance measurement,
unclick the Curved Distance Measure-
ment button.

If necessary, you can edit a curved distance
measurement by selecting the measure-
ment and moving the measurement points
you wish to correct.
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Evaluating Vessels
Curved distance measurement in the vessel
navigator

With a curved distance measurement you can
determine the length of a vessel section along
the path.

✧ Select a path and call up the vessel navi-
gator.

✧ Click the Measure curved distance but-
ton.

✧ Drag a line from the starting point to the 
end point of the measurement keeping the 
mouse button pressed.

The curved distance measurement is trans-
ferred to the object list.

Curved distance measurement in the image
segments

✧ Call up the Measurements function card 
and select the required path in the object 
list.

✧ Click the Measure curved distance but-
ton.

✧ Click the starting point of the curved dis-
tance measurement in the volume image.

✧ Click the end point of the curved distance 
measurement.

The shortest distance between the two points
is calculated with the path line and entered in
the object list as the curved distance mea-
surement.
V
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Evaluating Vessels
Measuring vessel cross-section

One vessel contour is always drawn in the
axial slice image segment in vessel orthogo-
nal orientation. You can apply this automati-
cally generated contour to area measure-
ments in the vessel navigator.

✧ Switch to orthogonal vessel orientation, if 
not already active.

✧ Move the focus pointer to the point to be 
measured on the vessel.

The axial slice image with the vessel contour
is updated.

✧ Click the Accept Contour button in the 
vessel navigator.

Or, if the contour suggestion is not suitable:

✧ Draw a new contour in the axial slice 
image (→  Page 55, Measuring an area).

Or

✧ Switch to contour editing mode, move the 
contour line to the correct position, and 
then accept the contour.

An area measurement is created and linked
to the path.
V
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Contour editing mode allows you to
change the shape of an existing
contour and then apply it. The asso-
ciated measurement values are
recalculated automatically.
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Evaluating Vessels
Measuring an area

You can also perform area measurement
independently of a path.

✧ Set a view suitable for the intended area 
measurement in the axial slice image seg-
ment.

✧ Click the Draw Contour button in the ves-
sel navigator.

✧ Draw the contour in the axial slice image 
using the mouse.

✧ Double-click to complete the contour.

The contour is evaluated and the area mea-
surement is entered in the object list.

Measuring angles

Set three measurement points in the image
segments for angle measurement: the apex
and one point for each leg of the angle.

✧ Click the Measure Angle button on the 
Measurements subtask card.

✧ Click the end point for the first side.

✧ Click the apex.

✧ Click the end point for the second side.

The angle is calculated and the angle mea-
surement is put in the object list.
V
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Session data are restored only by loading
the corresponding image series.

You can delete sessions you no longer
need from the series in the Patient Brow-
ser.
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Saving and Documenting

Saving and loading a session

You can save the current version of your work
on an image series.

Saving the session

✧ Select File > Save Session from the main 
menu.

The Session Management dialog box
opens.

✧ Enter a name for the session in the Ses-
sion Name input field.

✧ Click Save.

The session data for the image series will be
stored in the database.

Restoring a session

✧ Enter the image series for the session.

✧ Select File > Load Session from the main 
menu.

The dialog box for loading a session opens.

✧ Select the session that you want to restore 
from the list of existing session data.

✧ Click Load.

Vessel View returns to the status when the
session was saved.
V
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If you do not want to change the
storage settings click this button to
save.

Now the settings that you last made in the
Save As dialog box apply.
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Saving and Documenting
Saving images

To check the storage settings before each
save and make any necessary changes, pro-
ceed as follows:

✧ Select the image segment you want to 
save.

✧ Click the Save As button in the control 
area.

The Save As dialog box opens.

✧ Activate the relevant option to specify 
whether you want to create one series for 
all images or a separate series for each 
image type.

✧ Enter the name of the new series in the 
combo box next to the activated option.

In addition to the basic storage settings you
can provide additional information about the
series:

✧ Enter the name of the reporting physician 
or select a name from the selection list.

✧ Enter a comment about the images.

✧ Click OK to save the image.
V
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You can load the tables into the Viewing
task card via the Patient Browser or trans-
fer them to the Filming task card for print-
ing.
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Saving and Documenting
Creating evaluation tables

The report generator generates two tables:

❏ Measurements: Measurements sorted by 
type.

❏ Component description: Created paths 
and measurements with remarks.

✧ Click the Output Table button in the con-
trol area.

The tables are stored in the local database as
a new series.

Filming images

✧ Select the image segment view you want 
to transfer to the film sheet.

✧ Click this button in the control area.

Or

✧ Press the Copy to Film Sheet key on the 
symbol keybpad.

Depending on the film layout selected, the
images are transferred directly to the camera
or to the printer. Or they remain on the
Filming task card for processing until you
manually send the images to the camera or
printer.
V
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It is only possible to transfer coordinates of
MPR images to GSP.
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Saving and Documenting
Transferring images to the 
Viewing task card

After Vessel View, you can transfer images to
the Viewer for 2D-processing or evaluation.

✧ Select the image segment whose view you 
want to transfer to the Viewer.

✧ Click this button in the control area.

The image is stored and transferred to the
Viewer task card.

Sending image data for graphic 
slice positioning (GSP)

The coordinates transferred to GSP on the
Examination task card are automatically
used to measure the new slice.

✧ In a slice image segment set the MPR 
image whose image data you want to 
transfer.

✧ Select Send to GSP in the pop-up 
menu of the selected image.

The image coordinates are transmitted.
V
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You can use the Pause button to
interrupt recording briefly and then
resume it.
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Saving and Documenting
Recording a sequence of actions

You can record actions in a volume segment
in an avi film file.

✧ Click the Record button on the Movie sub-
task card.

The Save As dialog box opens.

✧ Enter a name for the movie file.

✧ Select the Record VRT interaction to AVI 
file item from the Save As selection list.

✧ Click Save.

The dialog box closes and recording starts.

✧ Perform the actions to be recorded in the 
volume segment.

✧ Click the Stop button to stop recording.
V
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An avi movie file can be replayed on other
systems using any multimedia software.

The image sequence in the volume seg-
ment is obtained by rotating the volume
about its vertical axis.

The image sequence in the vessel naviga-
tor is obtained by rotating the image plane
(flat ribbon) about the vessel axis.

The maximum number of 72 images results
in the smallest viewing angle interval of 5°
between two consecutive images.
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Saving and Documenting
Storing rotation of the view

You can store automatic rotation of the vessel
navigator view and automatic rotation of the
volume as an image sequence. You can spec-
ify whether to save the images in a new series
in the database or in an avi movie file in the
file system.

✧ Select the image segment for the record-
ing: the volume segment or the vessel nav-
igator.

✧ Display the Movie subtask card in the con-
trol area.

✧ Click the Record button on the Movie sub-
task card.

The Save As dialog box opens.

✧ Enter a name for the movie file.

✧ To save the image sequence to the data-
base, select the Save 360° rotation to 
database item from the Save As selection 
list.

Or

✧ To save the image sequence to the data-
base, select the Save 360° Rotation to 
AVI File item from the Save As selection 
list.

✧ Select the number of images with the 
slider.

✧ Click Save.

The dialog box closes and the image
sequence is stored.
V
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Workflow

Workflow of a Carotis examination

(1) Loading Images

Load the image series from the Patient
Browser into the Vessel View task card.
→  Page 9

(2) Optimizing the volume view

Select a suitable VRT parameter set from the
VRT Gallery to display the vessels in the vol-
ume image clearly.
→  Page 13

If necessary, optimize the individual parame-
ters in the VRT Definition dialog box.

(3) Defining and segmenting a path

Perform semi automatic segmentation. To
mark a vessel simply set a starting point at
the beginning and end of the vessel.
→  Page 25

The path is automatically defined and the
segmentation algorithm performed.

(4) Editing the path

Rotate the volume, move the slice image
planes, and zoom/pan to make the path
clearly visible in the image views. Check
whether the path runs through the center of
the vessel. If necessary, activate path editing
mode and correct the position of the path line.
→  Page 35
V
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Workflow
(5) Evaluating the vessel

Start the vessel navigator and rotate the
image plane of the view into a suitable posi-
tion.
→  Page 41

Change the flag number for stenosis evalua-
tion from two (default setting) to three if you
want to compare the stenosis with two healthy
vessel locations. Check and optimize the
position of the flags.

Measure the cross-sectional area of the ves-
sel at the flag positions. Accept the automati-
cally generated contour suggestion or draw in
a new contour. The cross-sectional measure-
ments in the stenosis (minimum flag) are
used to calculate the degree of stenosis that
is then displayed next to the stenosis (flag
Normal A and, if necessary, flag Normal B).
→  Page 45

If necessary, perform additional stenosis eval-
uations and measurements in the vessel nav-
igator, in the slice image segments, or in the
volume segment. The Measurements and
Vessel Navigator subtask cards provide
measurement functions for distances, curves,
angles, and surfaces.
→  Page 49 ff.
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Workflow
(6) Saving data

Using the Create Report function save a
table containing all evaluation results as a
DICOM image in the database.
→  Page 61

To represent your findings use the Record
function on the Movie subtask card. Use this
function to store rotation of the volume or ves-
sel navigator view as an image sequence in
the database or in an AVI movie file in the file
system.
→  Page 67
V
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Notes
V
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